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rights or the rights extended to others by lon Sense.
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Introduction to the Manual

The DARTControl application provides full control of the lonSense DART lon
Source hardware, including method management, hardware state management,
hardware status display and event logging.

This application was designed to be run on a PC equipped with a Microsoft
Windows XP operating system.

This manual contains instructions for installing and operating the DART Control
software and explains in details the functions of the various software elements
to assist the user in realizing the full potential of the DART lon Source.

1. Installing DARTControl Software

Insert the lonSense CD into the computer’s CD drive. If the DARTControl
installer does not automatically start, click on the file Installation.msi in the CD
directory to manually run the installer.

1.Select the Local Power Frequency
The application currently supports either 60Hz. (USA) or 50Hz (Europe)

2.Confirm the location to store Installation Files
The default folder assigned when downloading installation files is
C:/Program Files/DARTControl. The user may choose an alternate
location.

3.Confirm the location to store Method Files
When saving methods, this folder will initially be selected: C:/Program
Files/DARTControl/MethodFiles. The user may choose an alternate
location.

4.Confirm the location to store Log Files
When saving logs, this folder will initially be selected: C:/Program
Files/DARTControl/LogFiles. The user may choose an alternate
location.

Following completion of the installation sequence, the DARTControl application
will be ready for use. A shortcut will be placed on the desktop and in the Start
Menu. It is recommended that the user reboot the PC.



2. Launching DARTControl Software

Double click the DARTControl software icon on the desktop to launch the
DARTControl software

If the DART Control software icon does not appear on the desktop, open the
folder in which DART was installed (default C:/Program Files/DARTControl).

Click the right mouse button on the filename DARTControl.exe. Select Send to
Desktop to create a desktop icon.

[

DARTControl

When launched, the DART Control toolbar will open on your screen, as shown
below. Numbered elements on the image refer to the button descriptions in
Appendix A.
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3. Operating the DART Ion Source

The following flowchart describes the steps for operating and controlling the
DART lon Source. A detailed description of each of these steps is provided
below.
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3.1 Turning the DART lon Source on and off
On |OFF

The DART lon Source can be turned off and on by clicking the first button in the
DARTControl toolbar or by selecting System On / Off in the Control menu.
Turning off the system turns off and disables the voltages, heater, and gas.
Turning off the system using the application does not power down the DART
hardware.

3.2 Changing Electrode Polarity

Falarity|Palarity
e -—

Depending upon the desired mode of operation, while the system is on, the
polarity of one or both electrodes can be reversed by clicking the polarity
toolbar button. If both electrodes are positive, this button will make them both
negative (and vise versa). If the grid is negative and the discharge is positive,
the grid will become positive and the discharge will become negative. The
polarity may also be set by entering a positive or negative number when setting
the desired voltage in the Method Editor.

Setting both electrodes to positive is recommended for creating positive
ions, while setting both to negative is recommended for creating negative
ions.

3.3 Opening and Editing Methods

Methods contain predefined settings for the DART lon Source. The method
defines parameter values for operation of the DART lon Source in both the
Standby and Run states. Methods are created and modified using the Method
Editor, pictured below.

a. Opening a Method File
The most recently used method opens when DARTControl launches; a new
method can be created by clicking the toolbar button above or by selecting
Load New Method in the File menu. When a previously saved method file is

selected, it becomes the current method and the Method Editor opens to display
the saved parameter values.



Method Editor X

Method Name & | EEER QR Gases Flow Factor Flow Rate Default Gas
Auﬂ'u:ur:| GES?lilHE j | 0.3 | 4 Q
Comment : e s the default method. Gas #2: |NZ ﬂ | 0.%8 | & -
Gas £3: | AUX j| 1 | 4 r
(Gas List
Temperature : 250
Min. Flow Rate ; 0.55
Meedle Voltage : 3000 Gas Flow Increment f Decrement Step Size 1
Grid Electrode Voltage : 500 Standby State
Discharge Electrode Voltage : 400 Standby Gas: [N2 =

Standby Gas Flow Rate : 5

Heater Behavior :
" Turn Off Heater

{+ Maintain Runtime Temperature

" Maintain Standby Temperature

QK Cancel

b. Editing the Current Method File

With the DART lon Source hardware off, the current method can be edited by
selecting Edit Current Method in the File menu. After changing values, click
the OK button to save changes. If not saved, the changes will remain in effect
until the application is closed or a different method is opened.

c. Saving the Current Method File

The current method can be saved to disk by clicking the Save Method toolbar
button or selecting Save As... from the File menu if the user desires to assign a
different name to the method file.



3.2 Setting parameters for DART lon Source Operation

=
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The DART Status Window displays the real time status of the DART lon Source
hardware and allows the user to change some or all of the current method
settings. This window can be opened or closed by clicking the DART status
toolbar button, above, or by selecting DART Status in the View menu.
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a. System Graphical Display

The upper most section of the status page contains a graphical
representation of the current state and real time readings from the DART
hardware. Note that the voltage and temperature values shown in this
display are actual readings returned by the DART Controller sensors,
which may not exactly correspond to the parameters defined by the
current method or those entered by the user.
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b. Power Control

®Setting the Needle Voltage - If the DART lon Source is in the Run
state, the needle voltage can be set by entering a numeric value
directly into the Needle Voltage text box. Although the number that is
entered is positive, the needle voltage is actually always negative. The
needle voltage feedback displayed in the system graphic may not
exactly correspond to the voltage value entered into the edit box. The
maximum voltage setting for the needle is 5,000V, but the actual
voltage will typically not exceed 4,000V for N2 and 3,500 for He.

eEnabling or Disabling the Needle Voltage - While in the Run state,
the needle voltage can be turned on or off by clicking on the button
located above the Needle Current display. Note that the needle can
only be switched on if gas is flowing and no errors are detected. If
any status light is yellow or red, the needle can not be enabled until
the problem is corrected.

eSetting the Electrode Voltages - While the system is in the RUN
state, the voltage for the discharge and grid electrodes can be set.
These voltage values can be either positive or negative. As with the
needle voltages, the electrode voltage feedback displayed in the
system graphic reflects the actual sensor reading and may not exactly
match the method value entered. The maximum voltage for the
electrodes is +/- 650V.

c. Gas Control

When the system is in the ON state, the gas type and flow rate can be
set. Whereas four choices (Off, He, N,, and Aux) are available during
Standby, an operating gas (He, N, or Aux) must be selected in the Run
state. If the pressure of the selected gas source is below 35 PSI, the
system will report an error, the gas will be turned off and the system will
be placed in Standby.

The flow of the currently selected gas can be adjusted using the vertical
slider or by directly entering a number. Note that the numbers
indicated do not correspond to actual flowrate values, such as liters
per minute, but rather a relative measure used by the DARTControl
system.



d. Heater Control

When the system is in the ON state, the heater can be turned ON or OFF
and a target temperature can be set. The maximum heater temperature
is 500°C. The actual gas temperature will be lower by the time that it
comes in contact with a sample. Be advised that when switching between
Run and Standby, the heater settings will be changed to those defined by
the method currently in memory. If gas pressure or heater circuit errors
are detected, the heater turns off.

e. System Status

The system status indicates if the DART lon Source is functioning by
monitoring five connections: USB, gas pressure, the safety interlock, the
heater and the power. A green light means that the system is working
normally, while a red or yellow light indicates an error. When an error
occurs, high voltage turns off and cannot be turned on until the condition
is corrected and all status lights return to green.

A detailed description of the System Status indicators is provided in the
Troubleshooting section, below.

3.3 Running the DART lon Source

Tl

Standby | RUN

When the DART system is turned on, it is automatically put into the Standby
state. While in Standby, the gas and heater settings may be changed, but the
needle voltage cannot be enabled and the grid/discharge voltages cannot be
set. Typically, the Standby state is used while preparing a sample and the Run
state is used when analyzing the sample (primarily for the purpose of conserving
gas).

Note that changing states will cause all settings to revert to those defined
by the current method, for the given state.

Clicking the second button in the toolbar or selecting Standby / Run from the
Control menu will put the system in the Run state. While running, all settings
for the DART lon Source can be controlled. The system can be returned to the
Standby state by clicking the second toolbar button again or by selecting
Standby / Run from the Control menu. If an error is detected, the system will
automatically be placed into Standby.



4. Troubleshooting the DART Ion Source

Status buttons in the DartControl toolbar, readouts in the DART Status
Window and the lon Source Message Log assist the user with troubleshooting
problems with the DART lon Source and the DARTControl operating software.

4.1 Needle Voltage Status

aﬁ‘ 3

ON | OFF

This button, located on the DARTControl toolbar, is only a status
indicator; it will not turn the needle voltage ON or OFF. The needle can
only be turned ON and OFF in the DART Status Window or by selecting
Toggle Needle Voltage from the Control menu. While the needle voltage
is ON and the system is in the Run state, an image of the DART lon Source
with simulated “voltage” is displayed. While the needle voltage is OFF,

an image of the DART lon Source without the simulated voltage graphic is
displayed. The actual voltage applied to the needle is displayed in the
status bar. The needle voltage will turn off when an instrument error is
detected. Check the lon Source Message Log for additional information.

4.2 Sparking the Needle

&

Under certain circumstances, the needle may fail to respond to a
command to set its voltage. In this case, the needle may need to be
Sparked, which briefly applies the maximum voltage to the needle. Click
on the DARTControl toolbar icon above to “Spark” the needle, which
automatically ramps the voltage up to 5,000V and then back down to the
current method setting.

4.3 lon Source Message Log

As DART Control runs, it alerts the user through a hierarchy of status
messages. The three different levels are as follows:



Error Messages generated when a critical error condition is
sensed.

Warning Messages generated when something unusual occurs.

Informational Messages documenting changes under normal
operations, which are hidden by default.

The Message Log dialog can be opened and closed by clicking the
Message Log button, found in the DARTControl toolbar. The Message
Log dialog can also be opened and closed by selecting the menu item
Message Log in the View menu.

lon Source Message Log E|
Date / Time | Level | Message |
09/25/06 13:47:12 Info USE Error deared
09/29/06 13:47:12 Info Gas turned off,
09/29/06 13:47:12 Info Gas flow rate set to 0.00.
09/29/06 13:47:12 Info Heater turned off,
09/29/06 13:47:12 Info Hardware watchdog timer turned on.
09/29/06 13:47:13 Error APC_QuerySelectedGas: Call to HW _QuerySelectedGas failed.
Message Display Criteria
Clear Error Alert [ Errors [ warnings [ Info Save

When an error occurs, the Message Log toolbar button will flash until the
error condition is remedied. The error alert can be reset by opening the
Message Log window and pressing the button in the bottom left corner
labeled Clear Error Alert.

Once opened, displayed messages can be filtered by type using the
buttons in the bottom center of the window. The Message Log can be
saved into a comma separated values (CSV) file by clicking the Save
button located in the bottom right corner.

By default, the application automatically saves the Message Log to the
local hard drive, enabling viewing of Message Logs from previous runs.
This feature can be turned off by clearing the check box next to the Auto
Write feature found under the Logging menu on the Menu Bar. The
folder in which the files are saved is specified during the installation
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process, which by default is C:/Program Files/ DARTControl/LogFiles. It is
recommended that users keep auto-logging on and delete old log files
occasionally to save disk space.

4.4 DART lon Source System Status Indicators

The DART Status Window contains five indicators to monitor instrument
function. A green light means the system is working normally, while red
or yellow lights indicate an element of the DART lon Source System is not
operating properly. When an Error Message is generated, the system
reverts to Standby mode until the error is corrected.

USB: Turns red when the USB connection is lost. This error will cause
all of the other connections to fail. Check to see that the USB cable is
properly plugged into both the DART controller and the computer, and
that the power is on. If the DART controller is turned on after the
DART Control application has started, close the program and restart.

Gas Pressure: The pressure of the selected gas must be at least 35 PSI
for the DART controller to operate properly. An error will be reported
if the pressure drops below this value. Additionally, an error is
generated when the selected gas is not connected to the back of the
DART controller. A gas failure will turn off the heater. Check tank
pressures and all connections between the gas tank and the DART lon
Source if this monitor indicates an error.

Safety Interlock: Ensures that the DART lon Source is properly
connected and assembled. Removing the blue cover of the source will
create this error. If the Safety Interlock indicator is red, verify that
the DART lon Source is correctly connected. Refer to the DART lon
Source Installation Manual for more information.

Heater Circuit: Ensures that the heater is connected and functioning
properly. If this error message appears, check that the DART lon Source
is correctly connected to the controller.

Power: Makes sure that the DART controller is turned on. This error
will also cause the other connections to fail. If the DART controller is
turned on after the DARTControl application has started, close and
restart the program.
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Appendix:

This Appendix provides a short description of menu and toolbar elements in the
DartControl screen.

A-1. Graphical Interface — the Toolbar

1.Status Button
-Use this button to toggle the system status, ON or OFF.
2.Standby/Run Button
-This button changes the DART lon Source system status between Run
or Standby.
3.Anode Polarity
-This button allows for selecting positive or negative ion generation
by switching polarity of the two electrodes within the DART lon
Source.
4.Needle Voltage
-Use this button to turn the needle voltage ON or OFF.
5.Spark Needle
-Click on this button to “Spark” the needle with maximum voltage.
6.DART Status
-View the status of the Dart lon Source by using this button to open
or close the Status Window.
7.Message Log
+Click on this button to open the Message Log window.
-This button will flash when there is a new Error Alert. Opening the
Error Log and clicking the Clear Eerror Alert button will stop the
flashing.
8.0pen Method
-Use this button to open a previously saved DART Control method
file.
9.Save Current Method
-Save the current DARTControl method settings to a file selected by
the user by selecting this button.
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A-2. Graphical Interface — the Menu Bar

The DARTControl Menu Bar contains pulldown menus for File, Control,
View, Logging and Help that facilitate operating the DART lon Source.
Brief descriptions of these options are provided below:

oFile Menu
oEdit Current Method
«Opens the Method Editor.
oLoad Method
«Opens a previously saved method file.
oCreate New Method
«Creates a new method file.
oSave As...
=Saves the current method to a user selected file.
oShutdown & Exit
«Turns off voltages and exits the DARTControl program if the
temperature of the DART heater is less than 200°C.
eControl Menu
oSystem On / Off
=Sets system status to ON or OFF.
oStandby / Run
«Puts the system in Standby or Run state.
oToggle Needle Voltage
«Turns the needle voltage ON or OFF.
oOpen DART Status
«Opens the DART Status window.
oEnable Watchdog
«When enabled, the Watchdog continuously monitors the USB
connection from the computer to the controller.
oView
oDART Status
»Opens the DART Status window.
oMessage Log
«Opens the Message Log window.
eLogging
oAuto Write
«Enable or Disable automatic saving of log files.
eHelp
oAbout DARTControl
-Displays the version number.
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